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Drawing settings and preparing the drawing screen and worksheet 

When starting any new drawing, there are four basic rules that advised to 

follow: 

1- The units: - it means to specify the type of measurement unit used. 

2- The limits: - it means to determine the boundaries of the drawing. 

3- Zoom all: - It means to show the boundaries of the drawing. 

4- Draw. 

Units: 

The concept of units of measurement here is how the elements are measured, 

and what these measurements will look like. It must take into account the 

difference between this concept and the concept of measurement systems, the 

metric system or the English system. Determining the measurement system 

done in advance when opening a new drawing. 

 Drawing, a straight line in the program achieve by determining the length of this 

line and that this length is drawn in a specific unit, such a straight line of length 5 

units and can be equal to any type of unit in fact, such as feet, meters, 

kilometers, or miles. The type of units are chosen according to the type of 

drawing, for example, in the horizontal projection of a room, inch or centimeter 

is used or a centimeter, but when you draw a city, the units of kilometers and 

miles are appropriate. 

AutoCAD provides five types of different units, and you can choose the type that 

you want for your drawing from Format menu and select units after that the 

dialog window appears (drawing units). Note that the window is divided into 

two parts. The section located on the left side is the length window and related 

to the special settings for the length measurement. While, the section located 

on the right side of the window related with the special settings for the angles 

measuring. 
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If you click on the small arrow in the Type address box, you will see five types of 

The units as shown in the figure below. 
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Choose the type of units you want from the heading TYPE .Then go to the 

Insertion scale heading where this part is to specify the type of units for the 

graphics that you want to enter into the current drawing.  Then determine 

Precision that means the number of digits after the decimal point. 

 

 

 

 

 

 

 

 

 

 

From the angle section, choose the type of units for the angle                                  

measurement .The drop-down list of the Type box has five types, which are the 

well-known types: 

 Decimal degrees: Decimal system, angle parts are shown as a decimal fraction. 

Deg /Min/sec: The sexagesimal system is degrees, minutes and seconds. 

Grads: Metric system. 

Radians: The circular system, where the angle is written as 360=2 ᴫ degrees. 

Direction: When we draw in terms of a specific angle, the program takes it in 

counterclockwise direction and the angle of zero is with the positive axis of the 

X, if we want to change, the direction of drawing of the angle towards Clockwise, 

the Clockwise option should be activate. 

 

 

Set the drawing limits 

In Auto-cad, the drawing is done by a full scale without taking into account the 

limits of your drawing within a screen a drawing with infinite borders, providing 
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you with the possibility to draw the earth and even the solar system.  However, 

with this huge area of drawing limits, what would a drawing that   represents a 

horizontal projection of a house whose dimensions are 30m x 20m look like? You 

will not see it unless you enlarge it. This is why setting limits for your drawing 

becomes useful and makes it easier for you, drawing limits means creating 

imaginary limits on the drawing screen.                                                                          

                                                          

Proportion to the dimensions of your drawing that you will create, so   if we 

assume that you want to draw a house with dimensions of 40 x 30 m. You will 

specify the coordinates of the drawing limits as a rectangle. The coordinates of 

the first point is (0, 0), which is the lower left corner point, and the coordinate of 

the second point is (30, 40), which is the upper right corner. If you want to 

increase a margin to write a title for the drawing, the coordinates of the second 

point change                                        to become (34, 44) with an increase of four 

units as a margin for drawing. In any case, these limits will not affect your ability 

on the drawing with large limits and you will still be able to draw outside these 

limits                   only these limits will affect the size of grid if it activated. In 

addition, on the zoom in and out if there is no draw outside the limits.      

       

To do this, go to the Format menu and choose Drawing 
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When the command  execute, the message appears on the command line, 

asking to select the lower left corner for limits, press Enter to accept the 

AutoCAD default option.                                                                                                      

                                                                         

 
 

AutoCAD asks to specify the upper right corner of the drawing limits. Enter the 

coordinates of the upper right corner point, let it be (34, 44). Enter the X 

coordinates first, then the comma, after that the Y coordinates, finally press   

Enter.                                                                                                                              

From the View menu, select Zoom, and from the side menu, select all. 

 

You will not see any change on the screen because the new borders are invisible 

borders. in case you want to see                                                                     New 

borders , Activate the Grid button from the status bar at the bottom of the 

drawing screen, and this tool is used to help capture points to speed up the 

drawing process and will be explained  later with other tools.                                   

                                        

Standard paper sizes in mm 

  

 

 

 

 

 

 

  

 

 

 

 

 

 

 

Symbol Width Height 
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Helpful tools in Auto CAD 

 

The AutoCAD program contains a set of tools that help the user to draw             

accurately and quickly, such as using a network of orthogonal points and making 

 the cursor jumps specific distances that are set                                                         

According to the request or forcing the lines to be drawn perpendicular to the 

axes...etc., and these tools are located at the bottom of the drawing screen on 

the information bar or what is called the status bar .                                            

 

 

 

After its activation, this tool draws a network of orthogonal points that  : Grid
help to determine the boundaries of the drawing and know the distances by 

looking at it, the same as a graph paper. In addition, you can set up point 

spacing, angle, and point alignment as you like and it apply to a specific area. the 

network does not appear in the process of printing the drawing .                             

                       

The network can be linear, that is, composed of perpendicular lines or a point 

network and it depends on the preview mode of the drawing.  The linear grid is 

possible in all preview modes, except for the preview of two-dimensional.            

  

  

 

 

 

 

 

 

 

 

  

Dot grid 
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The type of preview select from the drop-down list Visual style < View 

Where drop down submenu with types of reviews will appear or write down 

Vscurrent in the command bar. 

setting: Grid 

1-from the Tools drop-down list Tools < Drafting setting The Utilities dialog 

window appears. 

2-By clicking on the tool icon grid Right mouse button, then select setting The 

same dialog window appears 

3- By writing the command Dsettings On the command bar, you get the same 

result. 

  

        

 

 

 

 

 

 

 

Linear grid 
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Through this tool, you can force the mouse cursor to move a certain  Snap:

distance, that is, to jump a certain distance around points that we select from 

the settings window. When you activate this tool, you will notice that the cursor 

movement it became heavy and its movement restricted, and this is useful in 

entering distances accurately and quickly. The jumping distances   must match 

the net distances.                                                                                                                 

                                                                                                                         Activate the 

snap by Clicking on the icon Snap in the utility bar and to disable it press once 

again on the icon, the tool becomes inactive (Snap of). You can also activate or 

disable the tool by pressing the key F9 from the keyboard.                                        

When you activate this tool, you force the mouse cursor to move  :Ortho

horizontally and vertically when drawing or modifying objects, and when 

drawing a line and after determine the starting point, you can watch the line as 

it moves only with the directions of the axes X, Y.                                      

    

To activate the perpendicularity feature (Ortho), click on the ortho tool in the 

utilities toolbar, and by clicking on it once again become inactive.                           

By activating this tool, you make the pointer follow the path Polar tracking:  

of a polar angle that you specify it from the settings window Put a √ sign in the 

polar tracking on box to activate the polar tracking feature.                                  

      

This tool is considered one of the most important auxiliary Object Snap: 
tools for drawing in AutoCAD, and it helps in determining the distinct points for    

the object accurately, such as the beginning of a line, the middle of a line, or the 

center of a circle...etc. Its importance reaches an extent that without it, we 

cannot perform some operations, such as obtaining the area of a shape, the 

length of a line, the coordinates of a point where obtaining the mentioned 

information requires identifying the item very accurately. As this tool helps you 

to draw a specific element starting with a distinct point on a drawn object.        

 

The task of this tool is to show command bar dialogs,  :Dynamic input

entries and information in a small box next to the cursor, which makes you focus 
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more on the drawing area instead of moving between the cursor and the 

command line                                                                                                                        

 

 
To activate and deactivate this tool, click on the tool icon with the left mouse 

button on the toolbar commands, or by pressing a key F12 from the keyboard. 

 

Dimensions 

Drawing any straight line requires a minimum of two points to be located on it 

to be drawn through the program at the PLANE level. There are several ways in 

which these known points are identified and set this straight line is known as the 

dimensions                                                                                                                            

   

There are three types of dimensions (Coordinates) 

1- ABSOLUTE COORDINAT 

2- RELATIVE COORDINAT 

3- POLAR COORDINAT  

 It is an accurate way to enter coordinates in the form :ABSOLUTE COORDINAT

(X,Y) then press ENTER this way used in the event that we know the coordinates 

It is often used in survey work.                                                                                           
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It is taken in relation to the last point that was  :COORDINATRELATIVE 

determined and written on the figure @X,Y then  ENTER , the @ symbol Auto- 

CAD reports that the distance starts from the last point that was determined.      

   

 

 

 

 

 

 

 

These coordinates are written relative to the last point  :COORDINATPOLAR 

 that was determined, as in the previous method, and the length of A straight      

   line   and an angle are preceded by the @ symbol  and write(@length of the    

straight line  < angle) then ENTER The angle is calculated starting from the x-axis 

and counterclockwise                                                                                                         . 

        

        

        

        

        

        

        

        

                                                                           

 

  

 

 

  



Auto CAD 2007 Lecture two 

 

06 
 

n the i Line Draw a square of side length 100 units using the command :Example

ways that have been explained. With the assumption The coordinates of the 

starting point are (150,150).                                                                                           

Solution: 

 Absolute Coordinates method 

1- On the drawing toolbar, click the line drawing tool Line Or type L on the  

command bar or from the Draw drop-down list, choose Line.                           

2- When an AutoCAD message appears SPECIFY FIRST POINT Enter the 

coordinates of the first point by typing (150,150) then ENTER to confirm the 

entry. First we enter the X axis and then the y axis separated by a comma on the 

keyboard to the side located on the lower right at the letter W . Note that the 

utility is disabled DYN on the status bar.                                                                         

3- When the Auto cad message appears SPECIFY NEXT POINT OR UNDO Enter 

the coordinates of the second point (150,250) then ENTER.                                

4- AutoCAD message will appear SPECIFY NEXT POINT OR UNDO after every 

time You choose a point at which you did not inform the Auto cad that your 

drawing was finished, and since we did not finish the drawing, you will we enter 

the coordinates of the third point, which is (250,250), then ENTER.                       

5- Input the coordinates of the fourth point, which is (250,150), then ENTER. 

6- Input the coordinates of the first point to close the drawing, which is 

(150,150), then ENTER.                                                                                            

7- To exit and finish, click ENTER. 
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 Relative coordinates method 

1- Choose the command Line in one of the ways previously described.  

2-When an AutoCAD message appears SPECIFY FIRST POINT Enter the 

coordinates of the first point By writing (150,150) then ENTER to confirm the 

entry.  

3- Input the coordinates of the second point, which is the length of the path 

traveled by the first point until you reach the second point with respect to the x 

and y coordinates preceded by the symbol @ in our case ,will be entered 0,100. 

 4- Input the coordinates of the third point relative to the second point, which is 

@100,0 . 

5-Input the coordinates of the fourth point relative to the third point, which is 

@0,-100 and note that The coordinates of the point with respect to the axis Y It 

has been entered with a negative value because its path From the second to the 

third point, reverse the positive direction of the axis.                                                   

6-Input the coordinates of the first point of the square to close the figure, 

relative to the third point, which is @-100,0 note that the coordinates of the 

point are relative to the axis X It has been entered with a negative value This is 

because its path from the fourth point to the first is opposite to the direction of 

the axis X .                                                                                                                              

7-To exit and finish, click ENTER . 
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Polar coordinates 

 

1-Choose command Line in one of the ways you know. 

2-When an AutoCAD message appears SPECIFY FIRST POINT Enter the 

coordinates of the first point By writing (150,150) then ENTER  to confirm the 

entry. 

3-Input the polar coordinates of the second point, which is @100<90 then  

ENTER.                                                                                                                                 

4- Input the polar coordinates of the third point, which is @100<0 then ENTER.    

5- Input the polar coordinates of the fourth point, which is @100<270 then 

ENTER.                                                                                                                                

6- Input the polar coordinates of the first point, which is @100<180 then ENTER. 

7- To exit and finish, click ENTER .                                                                                     
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Absolute coordinates 

 

  

 

 

 

 

 

 

 

Relative coordinates 
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Polar   coordinates 

 

  


